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I Symbols Used in This Document

A Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important

Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»» Note

* Icons may vary depending on your product.



I Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."



I Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad
Air, iPad mini, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other
countries.

» 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

» Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

» Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

* USB Type-C™ is a trademark of USB Implementers Forum.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR



OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work

and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or

Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of,

the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."



"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except
as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.



6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.



---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2012, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
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MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----
Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: Sciencelogic, LLC copyright notice (BSD) -----
Copyright (c) 2009, SciencelLogic, LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
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IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

LEADTOOLS
Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote

products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University
Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES

OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.
COPYRIGHT (c) 1989-2000.
On-Line Applications Research Corporation (OAR).
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Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated
Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it

will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley
Copyright (c) 1981-2000 The Regents of the University of California.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

2006-Jan-27
Copyright 1996-2002, 2006 by
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David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(Cas is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(‘royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. ('credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

Portions of this software are copyright © <year> The FreeType
Project (www.freetype.org). All rights reserved.
Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

Throughout this license, the terms “package’, "FreeType Project', and "FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
‘FreeType Project’, be they named as alpha, beta or final release.

“You' refers to the licensee, or person using the project, where “using' is a generic term including
compiling the project's source code as well as linking it to form a “program’ or “executable’.

This program is referred to as “a program using the FreeType engine'.
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This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED "AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: “FreeType Project', "FreeType Engine', "FreeType library',
or "FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts
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There are two mailing lists related to FreeType:
o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.
Our home page can be found at

http://www.freetype.org

---end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties

of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++
Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.
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ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License
Copyright (c) 2013-2017
Frank Denis <j at pureftpd dot org>

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS 1S" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE

OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
AS 1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

21



PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* Neither name of Intel Corporation nor the names of its contributors

may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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I Accounting Manager Guide

» General Notes (Accounting Manager)
» The Features of Accounting Manager
» Starting Accounting Manager
» Exiting Accounting Manager
» Accounting Manager Basic Procedures
@« Accounting Manager Basic Procedures
« Registering Printer
« Configure unit costs, including the costs of ink and paper
@« Setting Units Displayed
@« Setting List Display
@« Resident Service Settings
@« Unregistering Managed Printer
» Various Accounting Manager Features
« Filtering Settings
@« Tabulating Costs
@ Exporting Cost Tabulation Results to CSV File
« Exporting/Importing Job Logs as File
» Displaying Various Information
@ Checking Unit Costs Set on Printer
@« Checking Consumption
@ Checking Errors During Job Log Acquisition
» Description of Accounting Manager Screen
« Main Window
@« Filter Job Log Dialog Box
@ Cost Tabulation Dialog Box

@ Specified Unit Cost Dialog Box
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Ink and Paper Consumed Dialog Box
» Job Properties Dialog Box

Unit Costs Dialog Box

Resident Service Settings Dialog Box
Printer Management Dialog Box
Check Operation Status Dialog Box
Preferences Dialog Box

» Job Log Management Dialog Box
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I General Notes (Accounting Manager)

When using Accounting Manager, the following restrictions apply. Please familiarize yourself with them
before using it.

» See the Canon website for products that are compatible with Accounting Manager.

» This guide primarily provides explanations using the screens that appear when you use OS X Yosemite
10.10.

* When uninstalling Accounting Manager, stop the resident service first.

I Connecting to a Printer

» Connecting to a Target Printer
We recommend using a network connection for printer connection.
A USB connection is also possible, but job logs cannot be acquired during printing.
» Connecting via SSL Encrypted Communication
Connecting via SSL Encrypted Communication is available with Accounting Manager V1.2.0 or later.

In order to use SSL Encrypted Communication, you must first install a certificate on a computer with
Accounting Manager installed.

The process for installing the certificate may differ depending on your setup. For more information,
search for "Registering Printer's Root Certificate to Local Computer for SSL Communication" on your
device's online manual homepage.

I Power Status of a Target Printer

» The printer information cannot be acquired when the printer has auto powered off or has been turned
off with the Power button.

In addition, job logs or information cannot be acquired from the software when the printer auto power
off state or the printer button off state is canceled.

I Installing Updates
3% Important

» When updating from a previous version, the printer list and job logs will not be retained.

» To retain the printer list and job logs, export the printer list and job logs before updating.
After the update has been completed, import the exported printer list and job logs.

»>» Note

 For details on exporting and importing the printer list, see "Printer Management Dialog Box".
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 For details on exporting and importing job logs, "Exporting/Importing Job Logs as File" and see
"Job Log Management Dialog Box".
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I The Features of Accounting Manager

Accounting Manager is a software program that constantly communicates with managed printers to collect
job logs. The collected job logs are saved to the hard disk of your computer.

You can use Accounting Manager to do the following actions.

Print Job Log Collection
This allows you to check which documents were printed from each printer, who printed them and when.
Calculation of the Total Pages Used and the Total Cost

This allows you to use the collected print job logs to calculate totals for items such as the number of
pages printed, the amount of paper used and the printing costs incurred.

Regular Data Acquisition for Print Jobs
Acquires job logs regularly.
Exporting Job Logs

You can export the collected job logs to a file.

»» Note

If the computer on which Accounting Manager is installed is not turned on or is in Sleep mode and the
user is not logged in, the job logs cannot be collected.

* To acquire job logs without omitting any job logs, it is recommended that you install Accounting

Manager on the computer used for management and always log in with the same user name.

The acquired job log is saved for the user who is logged in.

22 Important

» Accounting Manager displays estimates for the amount of ink consumed per print and paper consumed.

The actual consumption may be different.

The average error for estimates based on the Canon ink cost measurement conditions is +15%. Canon
cannot guarantee the accuracy of these estimates. These estimates will also vary depending on the
conditions of printer use.

Note also that these estimates do not include ink consumed in procedures such as forced nozzle
discharges by the cleaning mechanism.
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I Starting Accounting Manager

Follow the procedure below to start the Accounting Manager.
Execute any of the following:
* Click the Accounting Manager button on the Management Tool sheet in the Quick Utility Toolbox.
+ Start from Application Icon
1. Open the Canon Accounting Manager folder.

Open the folders in the following order: Applications > Canon Utilities > Canon Accounting
Manager.

2. Double-click the Canon Accounting Manager icon.
Accounting Manager starts.

+ Start from Launchpad

o Click the Canon Accounting Manager icon from Canon Ultilities in Launchpad.
»>» Note
 Quick Utility Toolbox is a Canon software application.
* When Accounting Manager is started, job logs are not acquired.

When started, the acquired information appears, starting with the most recently saved job log.

You can acquire job logs at scheduled intervals using Scheduled Acquisition Settings in Advanced
Printer Settings and, as needed, by utilizing Refresh and Cost Tabulation.

+ If Resident Service Settings is set to Start and you register the managed printer, job log acquisition
starts.

29



I Exiting Accounting Manager

The procedure for exiting Accounting Manager is shown below.
+ Selecting Quit Canon Accounting Manager from the Canon Accounting Manager menu.
2> Note
« If the printer is being accessed when exiting, a message indicating that exiting is in progress appears.
After exiting is completed, Accounting Manager exits.

+ If Start is set in Resident Service Settings, job logs are acquired regularly in the background even
after exiting.
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I Accounting Manager Basic Procedures

» Accounting Manager Basic Procedures

» Registering Printer

» Configure unit costs, including the costs of ink and paper
» Setting Units Displayed

» Setting List Display

¥

Resident Service Settings

» Unregistering Managed Printer
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I Accounting Manager Basic Procedures

The first time you use the Accounting Manager, use the following procedures to configure the settings.

1. Registering Printer

For details on how to add a managed printer, see "Registering Printer."

2. Configure unit costs, including the costs of ink and paper

For details on the unit cost settings, see "Configure unit costs, including the costs of ink and paper.

3. Setting Options Such as Units Displayed

For details on the units setting, see "Setting Units Displayed."

4. Setting List Display

For details of how to set the list display, see "Setting List Display."

5. Resident Service Settings

For details on the Resident Service Settings, see "Resident Service Settings.

This displays the required print job logs and lists the details.

»>» Note

* You can save collected job logs to a file.

For details, see "Exporting/Importing Job Logs as File."
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I Registering Printer

Register printers to be managed.

1. Click —ﬁ' Printer Management button or select Manage Printer from Printer of File
menu.

& Printer Management

Registers a printer to be cost-managed. To remove a managed printer, select the printer,
and then click [Remove].

Printer List

Prinier Mame Connection Schedule.. Status Add Printer...
series feBO:eOblaSc.. ON

Import...

Export...

The Printer Management dialog box appears.

2. Click Add Printer button.

Searches for printers, and selects the printers to be registered.

Search Method: | Bonjour | Search |

IP Address: | |
Printer List:

| Printer | Serial Mumber | Connection |
O S BADMO0005 Canon TS _ca...
() W88 series  AEMGOD0006 Canon SN series-...
[ S series AETA13275 Canon W series-...
CJ T38MT1038 Canon . _can...
O - T44MT1030 Canon #ESE._can...
' " series  AEGKO00001 _Canon W 8 seri...

[ Search Options ] Stop Searching

(Gancel ] (_Add
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The Add Printer dialog box appears.
2> Note

 For details on the Add Printer dialog box, see "Printer Management Dialog Box."

3. Select Bonjour in Search Method, and then click the Search button.
The -printers found appear in Printer List.

> Note

* The Bonjour name for any printer with Bonjour enabled that is connected to the network will
appear in Connection.

« If the printer you want to register does not appear, check that the printer power is turned on and
check the network status, and then search again.

« If the printer still does not appear, change the Search Method to Auto (IPv4/IPv6), IPv4, IPv6, or
USB, and then search.

If you select IPv4 or IPv6, enter the IP address in IP Address.

* To search by SNMP Community, click Search Options, and then specify a Specify community
name.

* When Search Method is set to USB, a search for local printers is performed.

4. Select printer to be registered from printers found and click Add button.

The added printers appear in Printer List in the Printer Management dialog box.

5. Click Advanced Settings with printer selected in Printer List.

Sets the printer display and job log acquisition settings.
Printer Mame: || B8 8 series

Serial Number: 123456789

Scheduled Acquisition Settings
Run scheduled job log acquisition

Authentication

Password: ssss Auth. Test

Cancel Add

The Advanced Printer Settings dialog box opens.

6. Check Scheduled Acquisition Settings.

Check that Run scheduled job log acquisition in Scheduled Acquisition Settings is selected.
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7. Set Password in Authentication.
Set a Password in Authentication if necessary.
> Note

+ If the job history is set to hide on the printer control panel, authentication information is required
when acquiring job logs.

* For details, search for and refer to the "Administrator Password" page from the home page of the
Online Manual for your model.

After setting Password, click Auth. Test button to check authentication.

8. Click the Add button.

Settings are applied and the Advanced Printer Settings dialog box closes.

9. Click the OK button.

Information is acquired, and the printer is registered.

When the printer registration is completed, job log acquisition starts.
The acquired job logs are saved to your computer.

»» Note

» Before acquiring job logs, Accounting Manager refers to the MAC Address to check whether the
communication destination printer is the registered printer.

If the MAC address is different than the one for the registered printer, job logs are not acquired.

* For details on how to unregister a managed printer, see "Unregistering Managed Printer."
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I Configure unit costs, including the costs of ink and paper

Configure unit costs, including the costs of ink and paper.

»» Note

* Unit costs are set for each printer being managed.

I Opening Unit Costs Dialog Box

The Unit Costs dialog box opens.

1. Select printer you want to register unit costs for from printer list.

o,

2. Click the 32 Unit Costs button or select Unit Costs from Job Cost in the File menu.

The Unit Costs dialog box appears.

The Unit Costs dialog box consists of the following sheets.

Ink sheet : Setting the Unit Cost for Ink
Paper sheet : Setting the Unit Cost for Paper
Others sheet : Setting the Unit Cost for Items Other Than Ink and Paper

You can copy unit costs set on a printer to another printer using "Copying Unit Costs".

I Setting the Unit Cost for Ink

Set the ink unit costs using the Ink sheet.

Click Ink tab to display it.
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L Unit Costs (¢ saries )

Specifies the unit costs for ink, madia, and other serices.

.H' Papar | Others |
Unit Cost List:

| Ink Calor | Ink Tami Ca.... | 'Unit Coabs V]
4E00.000
|| Cyan a3 4EDD.00D
Chroma Optimizer 330 4B00.000
B Gray 330 AB00.00D
B Magenta 330 AB00.000
B Matte Black 350 AB00.000
B Fhoto Black as0 4B00.000
Phate Cyan 330 4EDD.00D
Photo Gray 330 4E00.000
Photo Magenta 330 AB0LD. 000
B Aed 330 B00.000
Yellow 330 4B00.000

Appty to All Inks
|_ .I'fcqu:r? Printar Inf::}rmg?.-?n | | Irn.pl;!rr.,... B E'KFIQF', - | Cm Unii.f_;ﬁr |

[ Cancet | [ Ok |

To set different unit costs for each ink color
1. Select ink to be changed.

2. Edit Unit Costs and Ink Tank Capacity directly in list.
To enable editing, double-click the item to be edited.

3. Click the OK button.

To set the same unit cost for all the inks
1. Select ink color to be copied.

2. Click Apply to All Inks button.
The selected ink unit cost and tank capacity are applied to all ink colors.

3. Click the OK button.

I Setting the Unit Cost for Paper

Set paper unit costs using Paper sheet.

Click Paper tab to display it.
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80¢ Unit Gosls (885 S8 sarles |

Specifies the unit costs for ink, media, and olher services,

{ Ink m Crhers |

Unit Cost List:
Meadia Type | Gizo [ Width fom] | Heigha [cm] | Nusiber of... | Ut Goats 1 |
veae Paper Was 10,000 10,000 100.000 i
Canvas Genaral P... 20,700 &2.000 1 85.000
Matte Phate Paper AT 20.700 42,000 1 60.000
Plain Papsr A3 20.700 42.000 1 B.000
Photo Paper Pro Presmium Maite A3 20,700 42,000 1 10,000
Photo Paper Ples Semi-gloss A3 20,700 42,000 1 80.0:00
Heavywaight Fine Art Paper A3 28,700 42,000 1 85,000
Extra Heavyweight Fine Art P... A3 20,700 42,000 1 120,000
Heavywaight Phate Pages A3 20700  42.000 . 90,000
Phato Paper Pro Lustar AT 20.700 42.000 % 17.000
Unknown Paper [custom-me... A3 20.700 £2.000 1 12.000
Plain Papr Ad 21.000 20.700 1 4000
Photo Paper Plus Glossy |l ad 21,000 26,700 1 40,000
Photo Paper Pro Platinum Ad 21.000 26,700 1 70.000
| Add [ Edit | [ Datate |
: Acguire Printer Infarrmation | Impart... J | Expert... | | Copy Unit Cost ]

((Cancel | oK |

Adding Paper Unit Costs
1. Click the Add button.

The Add Paper Unit Cost dialog box appears.

Media Type: Matte Photo Paper B

Other Media: ‘

Paper Size:
D General Purpose |

L3 ]

" Cut Sheet 11"%17" (Marain 25)

L]

Width [em] |

Height [em]
Number of Sheets/Ralls:

Unit Costs [¥]:

Acquire Printer Information Cancel Start

2. Set Media Type, Paper Size, and Unit Costs.
Set Width, Height, and Number of Sheets/Rolls as necessary.

23> Note

» For Roll Paper, specify the number of rolls in Number of Sheets/Rolls.
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3. Click Start button.
The unit cost settings you added are added to the Unit Cost List.

Editing Paper Unit Costs
The procedure for editing paper unit costs is shown below.

Editing the Unit Cost List in the List
1. Edit Width, Height, Number of Sheets/Rolls, and Unit Costs directly in Unit Cost List.

To enable editing, double-click the item to be edited.
2. Click the OK button.
When you finish editing, click OK button.
Editing with Edit Paper Unit Cost Dialog Box

1. Click Edit button.
The Edit Paper Unit Cost dialog box appears.

Media Type: = Plain Paper

Paper Size:
() General Purpose

© Cut Sheet [ A3

Width [cm] |245.700

Height [em] |42.000

Mumber of Sheets/Rolls: ﬂ 1 [

Unit Costs [J: |B.U'I}ﬂ |

|_- Cancel ] | Update ._'i

Acquire Printer Information |

2. Edit item to be changed.
3. Click the Update button.

When you finish editing, click Update button and close Edit screen.

4. Click the OK button.

I Setting the Unit Cost for Items Other Than Ink and Paper

Set the costs other than ink and paper costs on the Others sheet.

Click Others tab to display it.
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L Unit Costs (B saries )

Speoiﬁas this anit costs for ink, moedia, and other Services.

| Ink | Paper
Unit Cost List:
Eem | Uit Costs | | Allocato
Add | [ Edit | [ Delete |
| .l"u:quir.r.- Printer Information | Import... Enpeort.. | | Copy Unit Cost ]
[(caneel | [ oK |

Adding Other Unit Costs
1. Click the Add button.

The Add Other Unit Costs dialog box appears.

MName:
Unit Costs [¥]:

Add to Tabulation: = Yes

Cancel Start

2. Set each item.
Set Name, Unit Costs, and Add to Tabulation.
3. Click the Start button.

The unit cost settings you added are added to the Unit Cost List.

Editing Other Unit Costs
The procedure for editing other unit costs is shown below.

Editing the Unit Cost List in the List
1. Directly edit in list.
Edit Unit Costs and Allocate in Unit Cost List directly in list.

40



To enable editing, double-click the item to be edited.
2. Click the OK button.
When you finish editing, click OK button.
Editing with Edit Other Unit Cost Dialog Box
1. Click Edit button.
The Edit Other Unit Costs dialog box appears.

Name: other 0

Unit Costs [¥]: | 500.000

Add to Tabulation: No E

Cancel Update

2. Edit.
Edit items to be changed.
3. Click the Update button.
When you finish editing, click Update button and close Edit screen.

4. Click the OK button.

I Copying Unit Costs

Clicking the Copy Unit Cost button in the Unit Costs dialog box displays the Copy Unit Cost dialog box.

You can copy unit costs set on a printer to another printer.

Specifies the printer and items, and copies the unit cost settings.

Copy From: series E
Copy To:
Printer Category
series Ink
Paper
Others

e

close | (RN

1. Select printer to copy from.
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Select the printer from which the unit costs will be copied in Copy From.
2. Select printer to copy to.

Select the printer to be copied to in Copy To.
3. Select items to be copied.

Select the items to be copied in Category.

4. Click Start button.

»» Note

* For details on each item, see "Unit Costs Dialog Box."
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I Setting Units Displayed

Set the units displayed in Accounting Manager.

To open the Preferences dialog box, select Preferences in the Canon Accounting Manager menu.

I Setting Units
Set the units displayed in Accounting Manager on the Unit sheet in the Preferences dialog box.

] Preferences

View m Dthers

Date Display Format: | YYYY/MM/DD

Currency: || . |

1000 Separator: | Mone
Decimal Symbaol:
Paper Height/Area: @ Single Specification
Width: | cm

Height: | cm

gdgpgoool o

Area: | sguare meter

Cancel OK

Date Display Format
Use this option to select the display format for dates.

"YYYY" indicates the year, "MM" the month and "DD" the day.

Currency
Enter the currency unit.

Enter a text string up to 3 characters long.

1000 Separator
Use this option to select the symbol used as a separator in numbers.

The symbol is inserted every 3 digits.

Decimal Symbol
Use this option to select the symbol used as a decimal point.
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Paper Height/Area
Select paper dimension specification from Single Specification, In metric units, or In US
customary units.

Width
Use this to select the unit used for paper width.

Enabled when you select Single Specification in Paper Height/Area.

Height
Use this to select the unit used for paper length.

Enabled when you select Single Specification in Paper Height/Area.

Area
Use this to select the unit used for paper area.

Enabled when you select Single Specification in Paper Height/Area.
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I Setting List Display

Configure settings related to Accounting Manager display.

To open the Preferences dialog box, select Preferences in the Canon Accounting Manager menu.

I Setting Category to Be Displayed
Set the items displayed in the Job Cost list on the main screen.
Configure the settings in Category to Be Displayed on the View sheet in the Preferences dialog box.

@ Preferences

(U Unit  Others

Print Jobs Shown Per Page: | 500

S
Tabulation Period: = Weekly ﬁ
]

Tabulation Start Date: _r'u-'II::nr::Ieu..r

Category to Be Displayed:

Printer Mame

Account ID

Docurment Mame

Printing Results

Media Type

Printer Paper Size

Paper Consumed [sguare meter] Up
Paper Width [cm)]

Paper Height [cm] Down

Sooc0e00e.

Cancel oK

Print Jobs Shown Per Page
Specify the number of display items per page for job costs displayed in the Job Cost list.

Tabulation Period
Set the units for the tabulation period.

Tabulation Start Date
Set the tabulation start date for Tabulation Period.

»» Note

* You can display job logs for each period set in Tabulation Period and Tabulation Start Date.

Category to Be Displayed
Specify the job log items to be displayed in job cost.
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Selected items appear in the Job Cost list on the main screen starting from the left according to the
list's sort order.
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I Resident Service Settings

Configure the Resident Service Settings.

The resident service must be started to acquire job logs regularly.

Starting the resident service enables the resident service to start automatically when the user logs in.
2> Note

* For details, see "Resident Service Settings Dialog Box".

» The resident service must be configured for each logged in user.

To acquire job logs regularly, remain logged in with the user name that started the service.
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I Unregistering Managed Printer

Unregisters managed printers.

1. Click -i} Printer Management button or select Manage Printer from Printer of File
menu.

[ ] Printer Management

Registers a printer to be cost-managed. To remove a managed printer, select the printer,
and then click [Remove].

Printer List

Printer Mame Connection Schedule... Status Add Printer...

saries feBO:eOb0:alc.. ON

Import...

Export...

The Printer Management dialog box appears.

2. Select printer to unregister.

Select the printer you want to unregister from the printer list.

3. Click Remove button.

The Select Removal Method screen appears.

Selects the unregistration method.
If you select "Keep this on the printer list", yvou can
continue checking the job costs for that printer.

Keep this on the printer list
cancel | (TN

To keep the selected printer in the printer list even after it was unregistered, select the Keep this on the
printer list check box.

»» Note

» Job logs are not acquired from the printer after it is unregistered.
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* If you selected Keep this on the printer list, the printer remains in the printer list labeled
as (removed). You can view job logs acquired prior to unregistration even after the printer is
unregistered.

If it is not necessary to view the job logs, leave the Keep this on the printer list check box
cleared.

» To re-register a printer to be managed that was unregistered with the Keep this on the printer list
setting, delete it from the list, and then re-register it.

To delete the managed printer from the printer list, open the Select Removal Method screen, and
clear the Keep this on the printer list check box.

4. Click Start.

The settings are applied to the printer list.

5. Click OK.
The selected printer is unregistered.

»» Note

» For details on the Printer Management dialog box, see "Printer Management Dialog Box."
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I Various Accounting Manager Features

» Filtering Settings
» Tabulating Costs
» Exporting Cost Tabulation Results to CSV File

» Exporting/Importing Job Logs as File
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| Filtering Settings

You can display filtered items by configuring the Filter Job Logs.

1. Click Filter Job Logs on main screen.

The Filter Job Log dialog box appears.

& Filter Job Log

Selects the targets and conditions to be displayed in the job cost list of the main

SCraarn.

Printer: Period: Account |D E
All All Al

series 2015/07/01~2015/07/31 g

2071 5/08/01~2015/08/31
207 5/09/01~2015/09/30
2015/10/01=2015/10/31

Cancel OK

2. Select objects to be displayed.
Select the items to be displayed in the Job Cost list on the main screen.

Specify a range for Printer, Period, and Account ID/Department (Account ID2)/Owner for each item.

3. Click OK.

The job log selected in the Job Cost list on the main screen appears.
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I Tabulating Costs

You can specify the tabulation criteria and display the cost tabulation results in the Cost Tabulation dialog
box.

Click the @ Cost Tabulation button or select Cost Tabulation in Job Cost from the File menu to open
the Cost Tabulation dialog box.

(] Cost Tabulation

Specifies the conditions, and then tabulates the costs.

Printer: Pariod: Account ID B
All Al All
sarles 2019/02/18~2019/02/24

B 2019/02/25~2019/03/03 M| s
2019/03/04~2019/03/10
2019/03/11~2019/03/17
B 2019/03/18~2015/03/24
2019/03/25-2019/03/31
2019/04/01~2019/04/07

Total Job Cost [¥]: 1256.448

Target Number of Job: 25

Total Ink Cost [¥]: 43.800

Total Ink Consumed [mi]: 3.000

Total Paper Cost [W]: 1212.648

Total Paper Consumed [square meter]: 1.558
Total of Other Costs [¥]: 0.000

Export Unspecified Unit Cost Close Tabulate

I Setting Tabulation Criteria and Tabulating Cost

1. Specify tabulation criteria.

Specify the criteria for tabulation targets in Printer, Period, and Account ID/Department (Account
ID2)/Owner.

2. Click the Tabulate button.

The tabulation results for the specified criteria appear at the bottom of the Cost Tabulation dialog
box.

3. Export tabulation results to file.
Export the tabulation results to a file if necessary.

You can export the tabulation results to a CSV file by clicking the Export button.
»» Note

« If there is even one record for which a cost cannot be calculated, because the unit cost is not set,
"Cannot calculate the values to be tabulated because a unit cost has not been set." appears.

52



In this case, set the unit cost, and then tabulate the cost again.

= Configure unit costs, including the costs of ink and paper

You can check the items without unit costs by clicking Unspecified Unit Cost.

@ Unspecified Unit Cost

Unspecified Unit Cost List:

Printer Item Details
} . series Paper Plain Paper General Purpose
series Paper Plain Paper A3

« If an overflow of records for a tabulation target has occurred, "Cannot calculate the values to be
tabulated because a unit cost has not been set." also appears.

32 Important

« If "Cannot calculate the values to be tabulated because a unit cost has not been set." appears
because an overflow occurred in the records of the tabulation target, nothing appears in Unspecified
Unit Cost List.
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I Exporting Cost Tabulation Results to CSV File

You can export cost tabulation results to a file in CSV format. You can use this file when you want to
perform detailed analysis using tools such as spreadsheet software.

You can export the cost tabulation results to a CSV file by clicking the Export button in the Cost Tabulation
dialog box.

1. Open Cost Tabulation dialog box.
Select Cost Tabulation in Job Cost from the File menu to open the Cost Tabulation dialog box.

o Cost Tabulation

Specifies the conditions, and then tabulates the costs.

Printer: Period: Account ID H
8 a1 Al All
saries 20159/02/18~2019/02/24

B 2019/02/25-2019/03/03 145
2019/03/04~2019/03/10
2019/03/11~-2019/03/17
B 2019/03/18~2019/03/24
2019/03/25-2019/03/31
2019/04/01~2019/04/07

Total Job Cost [¥]: 1256.448

Target Mumber of Job: 25

Total Ink Cost [¥]: 43.800

Total Ink Consumed [ml]: 3.000

Total Paper Cost [¥]: 1212.648

Total Paper Consumed [square meber]: 1.558

Total of Other Costs [¥]: 0.000

Export Unspecified Unit Cosat Cloze Tabulate

2. Set tabulation criteria.

Specify the Printer, Period, and Account ID/Department (Account ID2)/Owner for cost tabulation.

3. Click the Tabulate button.
The cost tabulation results appear.

»» Note

* Clicking the Cancel button in the progress screen that displays the processing progress cancels
acquisition and tabulation and displays blank tabulation results.

« If there is even one record in the tabulation target for which a cost cannot be calculated, because
the unit cost is not set, "Cannot calculate the values to be tabulated because a unit cost has
not been set." appears.

« If an overflow of records for a tabulation target has occurred, "Cannot calculate the values to be
tabulated because a unit cost has not been set." also appears.
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4. Export cost tabulation results.
Click the Export button.
Specify a file name and destination, and then click the Save button.
You can export the tabulation results to a file in CSV format.

> Note

« If the tabulation results do not appear, the Export button is disabled.
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I Exporting/Importing Job Logs as File

You can export and import collected job logs as a file. This file can be used if you are replacing the
computer used for management, changing the job log destination, or increasing hard disk capacity.

I Exporting Job Logs

You can export collected job information with the Export sheet in the Job Log Management dialog box.

1. Open Export sheet in Job Log Management dialog box.
Select Manage Job Logs from the File menu.

Click the Export tab in the Job Log Management dialog box.

@ Job Log Management

import [JELCHE Delete

Exports the job logs.

Destination: ey
Target Printer: = Al ﬁ
Target Period: ) _ —
Close

2. Specify destination.

Specify the destination for the job logs in Destination.

3. Specify target printer.
Specify the printer for export in Target Printer.

Selecting All includes all managed printers.

»» Note

* Printers that were previously registered as managed printers but are no longer registered
appear with their MAC addresses.

4. Specify target period.
Specify the Target Period.

5. Execute export.

Click the Start button.
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Job logs are saved in the folder specified in Destination.

I Importing Job Logs
You can import an exported job information file with the Import sheet in the Job Log Management dialog

box.

1. Open Import sheet in Job Log Management dialog box.
Select Manage Job Logs from the File menu.

Click the Import tab in the Job Log Management dialog box.

& Job Log Management

m Export Delete

Imports the job logs.

File: Browse...

Close

2. Specify file.
Specify the file to be imported in File.

Click the Browse button to open the dialog box for specifying a file.

3. Execute import.

Click the Start button.
The job log specified in File is imported.
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I Displaying Various Information

» Checking Unit Costs Set on Printer
» Checking Consumption

» Checking Errors During Job Log Acquisition
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I Checking Unit Costs Set on Printer

You can display a list of unit costs set for the selected printer in the Specified Unit Cost dialog box.
1. Select printer whose unit costs will be checked.

2. Display Specified Unit Cost dialog box.
Select Specified Unit Cost in Job Cost from the File menu.
The Specified Unit Cost dialog box appears.

& Specified Unit Cost | series)

Specified Unit Cost List:

Item Details Unit Cos... Allocate
Blue Ink Tank Capaci... 850.000 Yes
Cyan Ink Tank Capaci... 850,000 Yes
Chroma Optimizer Ink Tank Capaci... 850,000 Yes
Gray Ink Tank Capaci... 850.000 Yes
Magenta Ink Tank Capaci... 850.000 Yes
Matte Black Ink Tank Capaci... 850.000 Yes
Photo Black Ink Tank Capaci... 850.000 Yes
Photo Cyan Ink Tank Capaci... 850.000 Yes
Photo Gray Ink Tank Capaci... 850.000 Yes
Photo Magenta  Ink Tank Capaci... 850.000 Yes
Red Ink Tank Capaci... 850.000 Yes
Yellow Ink Tank Capaci... 850.000 Yes
Dlain Damar fRamaral Dirmae 4 nnn W
Ok ]
»>» Note

* For details on Specified Unit Cost, see "Specified Unit Cost Dialog Box."
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I Checking Consumption

You can check the ink and paper consumed for each printer or for each job.

I Checking Ink and Paper Consumed Per Printer

You can check the consumed ink and paper up to present for the selected printer in the Ink and Paper
Consumed dialog box.

»>» Note

¢ For details, see "Ink and Paper Consumed Dialog Box."

I Checking Consumption Per Job

The Job Properties dialog box displays detailed information about the selected job, including cost
information.

»» Note

¢ For details, see "Job Properties Dialog Box."
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I Checking Errors During Job Log Acquisition

Errors that occur during job log acquisition can be displayed in the Check Operation Status dialog box.

Click Check Operation Status in the Tools menu to display.

»» Note

* For details, see "Check Operation Status Dialog Box."
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I Description of Accounting Manager Screen

>

>

>

Main Window

Filter Job Log Dialog Box

Cost Tabulation Dialog Box
Specified Unit Cost Dialog Box

Ink and Paper Consumed Dialog Box
Job Properties Dialog Box

Unit Costs Dialog Box

Resident Service Settings Dialog Box
Printer Management Dialog Box
Check Operation Status Dialog Box
Preferences Dialog Box

Job Log Management Dialog Box
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| Main Window

The Accounting Manager main screen consists of the title bar, main menu (toolbars), job cost list area,
printer list area, status bar, and target period and filtering button area.

N ] Canon Acouring Manags
D 8 C 7 (1)
i Page i
Dislarying Job Cads L st | Prvai hodemat Aigw . DX i Prvsing Rlean  Maka Ty Privas Pag
érien 437 5e... LS Diceumannt | Comyplets Pain Fupsr wa
arion 3118 4. am [ Lignbwanghl... A4
Mot Cuaplaying Jok Gl 43408 aa... US Deecurrat Cospleta Plais Pager A4
8310 ... LS Decumantl Cosplets Plain Pagar A3
oL ... LG Document? Complets Phote Paper.., Ad
4308 ... LIS Documentt Complets Lun Fapar Ad
TR 2M B, LS Baumanid Gompiete Photc Paper.,, A
B0 208 B LS Decumantt!  Complate Haprpawught.., Ad
BO.TEE 8. LIS Dhcezaimant ! Complats Mistts Phaoto... A3
':: 2 :l & 308 (4 :l sa... LIS Chzazirmantd Cormpleia Pelai Pateer A
B30 84... L8 Desviranil [e ] P Papssr A3
& 308 ... LS Deuamndt Cormphate Plain Pagser Ad
£308 .., S Decungnt i Cosplate Piain Pager Ad
4308 ... LS Decumentt Complets Plairs Pager A
BORLE ., LS Documentl1 Completa lagrpmoeghs .. Ad
L2 =, LS Documant! Complats MigHe Bhoin,.. Ad
|- B k] L, UG Dhocumant | Gompleta Plain Pagesr L]
0208 . UGS Dicumant] ot Phcba Papsr. L2l
To.234 ... LIS Dizcurmantd [ ] Praoba Paper. L2
Target Pericd 4308 84, LS Cozeismget § Complets Plain Fgesr A
Al Pariady (3 j
Fiter Jabr Loge
Jobis}: 0720 {5} DCate of Las Upsater 20168/01/06 14:34:18
= (1) Toolbars
= (2) Printer List Area
= (3) Target Period/Filtering Button Area
= (4) Job Cost List Area
= (5) Status Bar
= Main Menu (Menu Bar)

I (1) Toolbars

The toolbars include the Standard toolbar and the Navigation toolbar.

= .m e g C ?

| Move Page: 11

You can opt to either show or hide the toolbars with Toolbars in the View menu.

Standard Toolbar
Execute buttons for most frequently used features are located here.

. —'i} Printer Management button

The Printer Management Dialog Box appears.

Register and unregister managed printers and change their settings.
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—

. 32 Unit Costs button

The Unit Costs Dialog Box appears.

Set unit costs for ink, paper, and other unit costs.

Enabled when the target printer is selected in printer list.

. & Export Job Cost Data button
Export the selected job cost information to a CSV file.

Enabled when job cost is selected in the Job Cost list.

—

. 52 Cost Tabulation button

The Cost Tabulation Dialog Box appears.

Specify the criteria and tabulate cost.

C

. Refresh button

Acquire and display the latest job logs.

l?

* ® Help button
Display the Help.

Navigation Toolbar
Features related to page navigation are located here.

[ shee

. Show First Page button
Go to the first page.

Several pages comprise the Job Cost list and this button is enabled except on the first page.

. Show Previous Page button
Go to the previous page.

Several pages comprise the Job Cost list and this button is enabled except on the first page.

. Show Next Page button
Go to the next page.

Several pages comprise the Job Cost list and this button is enabled except on the last page.

. Show Last Page button
Go to last page.

Several pages comprise the Job Cost list and this button is enabled except on the last page.
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| (@ Printer List Area

A list of printers registered as currently managed printers appears.

Displaying Job Cost List
series
Not Displaying Job Cost

I (3) Target Period/Filtering Button Area

Target Period:
2015/08/01 - 2015/10/31

Filter Job Logs

Target Period
Target Period displays the current display criteria for the Job Cost list.

Configure the period in Filter Job Log.
3> Note

« If the specified target period is a consecutive period, this period appears.

65



Pariod:

Al Target Period:
2015/07/01~2015/07/31
2015/08/01~2015/08/31 2015/08/01 - 201510/31

201 5/08/071 ~201 5/08/30

Filter Job Logs
2015/10/01 ~2015/10/31

If non-consecutive periods are specified, the period appears with an * (asterisk) appended to the

end.
Pariod:
All Target Period:
2015/07/01~2015/07/31
2015/08/01~2015/08/31 sl Db e e

201 5/09/01=2015/00/30

Filter Job Logs
8 2015/10/01~-2015/10/31

Filter Job Logs button
Click the Filter Job Log button to display the Filter Job Log Dialog Box.

Filter Job Log dialog box
Select the items to be displayed in the Job Cost list on the main screen.

Specify a range for Printer, Period, and Account ID/Department (Account ID2)/Owner for
each item.

& Filter Job Log

Selects the targets and conditions to be displayed in the job cost list of the main

SCrean.

Printer: Period: Aceount ID E
Al All Al

series 2015/07/01~2015/07/31 1S

201 5/08/01~2015/08/31
201 5/08/01=2015/08/30
201 5/10/01-2015M10/31

Cancel QK
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I (4) Job Cost List Area

Iltems including Cost, Account ID, Document Name, Printing Results, Media Type, and Paper
Consumed appear.

Cost | Printer Mama Accoy.,, Document Mamg  Printing Results  Media Type Priniar Pap
4.207 sa... IS Decumenti Complate Plain Paper g
38.119 58, m Complate Lightwaight... A4
4,308 se... S Docurment1 Complete Plain Paper Ad
8.310 5&,.. IS Document Complete Plain Paper A
70.234 se... S Document2 Complete Photo Paper... Ad
4.308 se... WS Document Complate Plain Paper A4
70.234 se... WS Document2 Complate Photo Paper... Ad
50.2568 se... IS Documantii Complate Heavywaight... A4
80.293 sa... IJS Decument Complate Matte Photo... A3
4.308 se,.. IS Docurmnent Complate Plain Paper g
B.310 s8... IS Documentl Complate Plain Paper A3
4.308 se,.. IS Documenti Complate Plain Paper Ad
4.308 se.. LUS Document Complate Plain Paper A4
4.308 ge... IS Document Complete Plain Paper A4
50.256 se... IS Documentii Complate Heavyweight... Ad
B0.283 sa... IS Documenti Complate Matte Photo... A3
B.210 se... IS Document Complate Plain Paper A%
40,268 se... WS Document3 Complate Photo Paper... A4
70,234 se... WS Document2 Complate Photo Paper... A4
4.308 se... IJS Document1 Complate Plain Paper A4
Cost

The cost of printing.
» Total cost of job: (ink + paper + other costs)
If the cost cannot be calculated because the ink and paper unit costs have not be set, *** appears.

Printer Name
The name of the printer that printed the job appears.

Account ID
The Account ID set for the job appears.

22 Important

* When a user (the person printing) sends a job to the printer, they must include identifying
information connected to the person who sent the job (Account ID, Department (Account ID2), or
Owner).

For details, see the User Manual for your model from the Home of the Online Manual.

Document Name
This is the name of the printed document.

Printing Results
The printing results for the job appears.

Displays Complete if the printing is executed, Canceled if the printing is not executed, Error if an
error occurs, and Warning if an error occurs in the print job data.
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Media Type
This is the type of paper used in printing.

The paper name based on the information acquired from the printer appears.

»» Note

» Displays Unknown Paper if the relevant paper name cannot be acquired.

Printer Paper Size
Size indicating the print area of the job.

Paper Consumed
This is the area of paper used in printing.

Paper Width
This is the width of paper used in printing.

Paper Height
This is the length of paper used in printing.

Ink Consumed
Amount of ink used in printing (total consumption for each color).

Owner
The sender (owner's name) of the job.

The user name of the user logged into the OS is assigned.

Print Job Start Time
Time printing started.

The Print Job Start Time that will appear in the Job Cost list is as follows:

When Time Zone Set on Printer
Displays the time converted from the time zone set on the computer running Accounting
Manager.

When Time Zone Not Set on Printer
Displays the time in the time zone set on the computer running Accounting Manager.

Print Time
Time it took to print the job.

Pages
The number of pages printed.

The number of impressions (number of surfaces) for the job appears.
For a job where 3 copies of a 2-page original are printed, it is "6".

Print Quality
Level of print quality for the job.

Paper Cost
The cost of paper used for printing.

Total Ink Cost
Total cost of ink used in printing (total ink cost for each color).
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Total of Other Costs
The total value of costs other than paper and ink.

Ink Cost Details
The cost per color of ink appears.

Ink Consumption Details
The amount of each color of ink used.

job_description
The ID set for the job appears.

Print Priority
The Print Priority settings selected when printing appear.

Paper Source
The Paper Source when printing appears.

Department (Account ID2)
Displays the Account ID2 specified in the job.

Project number
Displays the project number specified in the job.

Order number
Displays the order number specified in the job.

Customer ID
Displays the customer ID specified in the job.

Job number
Displays the job number specified in the job.

Comment
Displays comments specified in the job.

> Note

* The items shown vary depending on your model.

* In the Preferences Dialog Box, set the number of jobs, items, and sort order displayed in the Job Cost

list.

« If all of the jobs extracted based on the filtering criteria do not fill up the configured number of jobs,
they all appear on one page. The most recent job logs on the first page appears if the configured
number of jobs is exceeded. The portion exceeding the configured number of jobs appears on the

second and subsequent pages.

« If overflow occurs in the calculation results, --- appears.

I (5) Status Bar

Messages including notifications that job log acquisition errors have occurred, descriptions of functions,

job selection status, and last update date/time appear.

dobisl: V0  Duteol Laas Updne: J096%108 163400
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I Main Menu (Menu Bar)

Select the menu items for the necessary operations.

= Canon Accounting Manager Menu
= File Menu

= View Menu

= Tools Menu

= Help Menu

I Canon Accounting Manager Menu

@l Canon Accounting Manager [z1CRN =TI SERY/EUVERE (Y-S
About Canon Accounting Manager

Preferences... 8,

Hide Canon Accounting Manager #H
Hide Others NEH
Show All

! Quit Canon Accounting Manager  32Q)
About Canon Accounting Manager
The About dialog box appears.

Preferences
The Preferences Dialog Box appears.

Specify your preferences (settings related to displayed content and displayed items) for Accounting
Manager.

Quit Canon Accounting Manager
Close the main window and exit Accounting Manager.

»>» Note

« If Start is set in Resident Service Settings, job logs are acquired regularly in the background
even after exiting.

| File Menu

& Canon Accounting Manager m Edit View Tools Help

Printer | ]
Job Cost 3
Manage Job Logs... 384

Printer
& Canon Accounting Manager m Edit View Tools Help
TSN a0 Frinter... %M
Job Cost L

Ink and Paper Consumed ¥G
Manage Job Logs... %

Manage Printer
The Printer Management Dialog Box appears.
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Register and unregister managed printers, and change settings for managed printers in the
Printer Management dialog box.

Also, you can import and export managed printers.

Ink and Paper Consumed
The Ink and Paper Consumed Dialog Box appears.

You can check the ink and paper consumed up to the present for this printer.

Enabled if a printer is selected in the printer list.

Job Cost
& Canon Accounting Manager I Ecit View Tools Help
Printer L4
Cost Tabulation... T
Manage Job Logs... MJ
Unit Costs... =U
Specified Unit Cost T+EU

Cost Tabulation
The Cost Tabulation Dialog Box appears.

You can specify tabulation criteria and tabulate costs here.

Export Job Cost Data

Export cost information in CVS format for jobs selected in the Job Cost list on the main screen.

Enabled when a job is selected in the Job Cost list.

Unit Costs

Displays the Unit Costs Dialog Box for the printer of the job selected in the Job Cost list on the

main screen.
Enabled if a printer is selected in the printer list.

Specified Unit Cost
The Specified Unit Cost Dialog Box appears.

You can check the list of unit costs set on the printer here.
Enabled if a printer is selected in the printer list.

Manage Job Logs
The Job Log Management Dialog Box appears.

Execute operations related to job logs (import, export, move, and delete).

I View Menu

& Canon Accounting Manager File Edit Tools Help

Toolbars >
+ Status Bar 3/
Go 3

Filter Job Logs... 38F
Refresh ®AR
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Toolbars
& Canon Accounting Manager File Ecit [ Tools Help

Toolbars Ml / Standard X8
+ Status Bar x|, Mavigation {r¥N
Go 3

Filtar Job Logs... 36F
Aefrash R

Show or hide Toolbars.

Toolbars include the Standard Toolbar and Navigation Toolbar, and you can show and hide each
toolbar.

Status Bar
Show or hide Status Bar.

Messages including notification for job log acquisition errors settings, descriptions of functions, job
selection status, and last update date/time appear.

Go
® Canon Accounting Manager File Edit m Tools Halp
Toolbars L4
 Status Bar =/
Fitter Job Logs... ¥F

Rairash xR

Navigate between pages.
Choose from the following methods of navigation.
» Show First Page
Several pages comprise the Job Cost list and this button is enabled except on the first page.
+ Show Previous Page
Several pages comprise the Job Cost list and this button is enabled except on the first page.
* Show Next Page
Several pages comprise the Job Cost list and this button is enabled except on the last page.
» Show Last Page
Several pages comprise the Job Cost list and this button is enabled except on the last page.

Job Properties
The Job Properties Dialog Box appears.

You can check detailed information for job costs.
Enabled when a job is selected in the Job Cost list.

Filter Job Logs
The Filter Job Log Dialog Box appears.

Select the items to be displayed in the Job Cost list.

Refresh
Acquires and displays the latest job logs.
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Acquires the most recent job logs from printers specified in the extraction criteria to update the Job
Cost list.

I Tools Menu

#® Canon Accounting Manager Fila Edit View Help

Resident Service Control... 3D
Check Operation Status HL

Resident Service Control
The Resident Service Settings Dialog Box appears.

Displays the operating status of the resident service, and controls the start and stop of the resident
service.

Check Operation Status
Displays the Check Operation Status Dialog Box.

Displays a list of errors that occurred during job log acquisition from the printer.

I Help Menu
& Canon Accounting Manager File Edit  View Tnn:r.m
Senrch | [ %]
Instructions
Disclaimar

Instructions
Displays the Accounting Manager guide.

Disclaimer
Displays a disclaimer.
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I Filter Job Log Dialog Box

Select Filter Job Logs from the View menu to open the Filter Job Log dialog box.

& Filter Job Log

Selects the targets and conditions to be displayed in the job cost list of the main

SCrean.
Printer: Period: Account 1D E
& 2 All & A
geries 2015/07/01-2015/07/31 (W]
2015/08/01~2015/08/31
201 5/09/01~2015/09/30
20715/10/01=2015/1 0/31
Cancel OK
Printer
Displays the list of All printers or printers registered as managed printers in the Printer Management
dialog box.
Period

Displays a period list created based on All or Tabulation Period and Tabulation Start Date settings and
the print date for the oldest record among the job logs saved to the local database.

Account ID/Department (Account ID2)/Owner
In the drop-down menu, specify either Account ID, Department (Account ID2), or Owner as extraction
criteria.

The Account ID, Department (Account ID2), or Owner list will appear, including an All option, as well
as all printers and job logs saved to the local database.
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I Cost Tabulation Dialog Box

Select Cost Tabulation in Job Cost from the File menu to open the Cost Tabulation dialog box.
You can specify tabulation criteria and tabulate costs.

@ Cost Tabulation

Specifies the conditions, and then tabulates the costs.

Printer: Period: Account ID B
8 Al AN All
safles 2019/02/18~2019/02/24

[ 2019/02/25~2019/03/03 B s
2019/03/04~2019/03/10
2019/03/11~2019/03/17
B 2019/03/18~2019/03/24
2018/03/25-2019/03/31
2019/04/01~2019/04/07

Total Job Cost [¥]: 1256.448

Target Number of Job: 25

Total Ink Cost [¥]: 43.800

Total ink Consumed [mi]: 3.000

Total Paper Cost [W]: 1212.648

Total Paper Consumed [square meter]: 1.558
Total of Other Costs [W]: 0,000

Export Unspecified Unit Cost Cloze Tabulate

Printer
All and the list of printers registered as managed printers in the Printer Management dialog box are
displayed.

Period

Displays a period list created based on All or Tabulation Period and Tabulation Start Date settings and
the print date for the oldest record among the job logs saved to the local database.

Account ID/Department (Account ID2)/Owner
In the drop-down menu, specify either Account ID, Department (Account ID2), or Owner as extraction
criteria.

The Account ID, Department (Account ID2), or Owner list will appear, including an All option, as well
as all printers and job logs saved to the local database.

Total Job Cost
The total costs for extracted jobs appears.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Number of Target Jobs
The total number of extracted jobs appears.

Total Ink Cost
The total ink costs for extracted jobs appears.
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*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Ink Consumed
The total ink consumed for extracted jobs appears.

Total Paper Cost
The total paper costs for extracted jobs appears.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Paper Consumed
The total paper consumed for extracted jobs appears.

Total of Other Costs
The total costs other than ink and paper for extracted jobs appears.

Export button
Exports the tabulation results and the job cost records of the extracted jobs in CSV format.

Enabled if tabulation results exist.

Unspecified Unit Cost button
Calculates costs according to extraction criteria and lists unit costs with inadequate settings.

Job logs are not acquired from the printer at this time.

The list of unspecified unit costs appear in the Unspecified Unit Cost Dialog Box.

Tabulate button
Tabulates costs.

To acquire job logs from the target printers, click the Tabulate button.

Extracts job logs, calculates costs, and displays tabulation results when job log acquisition from all
target printers is completed.

»» Note

« Clicking the Cancel button in the progress screen that displays the processing progress cancels
acquisition and tabulation and displays blank tabulation results.

* If there is even one record in the tabulation target for which a cost cannot be calculated, because
the unit cost is not set, "Cannot calculate the values to be tabulated because a unit cost has
not been set." appears.

+ If an overflow of records for a tabulation target has occurred, "Cannot calculate the values to be
tabulated because a unit cost has not been set." also appears.

»» Note

« If overflow occurs in the calculation results, --- appears.

« If --- appears, check the unit costs and tabulation period settings are appropriate.
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I Unspecified Unit Cost Dialog Box

When the job cost calculation is performed using the criteria specified in the Tabulate screen, inadequate
unit cost settings are extracted and appear in the Unspecified Unit Cost dialog box.

@ Unspecified Unit Cost

Unspecified Unit Cost List:

Printer Item Details
: . series Paper Plain Paper General Purpose
series Paper Plain Paper A3

Unspecified Unit Cost List
Printer
The printer name appears.

Item
Ink or Paper appears.

Details
The details for target items appear.

32 Important

« If "Cannot calculate the values to be tabulated because a unit cost has not been set." appears
because an overflow occurred in the records of the tabulation target, nothing appears in Unspecified
Unit Cost List.
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I Specified Unit Cost Dialog Box

You can check a list of unit costs set for this printer in the Specified Unit Cost dialog box.
Select Specified Unit Cost in Job Cost from the File menu to open the Specified Unit Cost dialog box.

i Specified Unit Cost | series)

Specified Unit Cost List:

Item Details Unit Cos... Allocate
Blue Ink Tank Capaci... 850.000 Yes
Cyan Ink Tank Capaci... 850.000 Yes
Chroma Optimizer Ink Tank Capaci... 850.000 Yes
Gray Ink Tank Capaci... 850.000 Yes
Magenta Ink Tank Capaci... 850.000 Yes
Matte Black Ink Tank Capaci... 850.000 Yes
Photo Black Ink Tank Capaci... 850.000 Yes
Photo Cyan Ink Tank Capaci... 850.000 Yes
Photo Gray Ink Tank Capaci... 850.000 Yes
Photo Magenta Ink Tank Capaci... 850.000 Yes
Red Ink Tank Capaci... 850.000 Yes
Yellow Ink Tank Capaci... 850.000 Yes
Dlain Damar fRamaral Dirman 4. Ann Weam

SOk

Specified Unit Cost List
Item
The item names of unit cost settings specified for Ink, Paper, and Others appear.

Details
The details for items appear.

Unit Costs
The unit costs set for items appear.

Allocate
Yes appears when the set unit cost is used in job cost calculation.

Items that are not used are blank.

78



I Ink and Paper Consumed Dialog Box

You can check the ink and paper up consumed to the present for this printer in the Ink and Paper
Consumed dialog box.

To display the dialog box, click Ink and Paper Consumed from Printer in the File menu.

& Ink and Paper Consumed | Series)

Ink and Paper Consumed List:

tem Valug

Total Sheets of Paper Consumed (Co... 10000
Total Photo Magenta Ink Consumed [mi] 100.000
Total Red Ink Consumed [ml] 100.000
Total Cyan Ink Consumed [mi] 100.000
Total Photo Gray Ink Consumed [ml] 100.000
Total Matte Black Ink Consumed [mil] 100.000
Total Photo Black Ink Consumed [mil] 100.000

Total Blue Ink Consumed [mil] 100.000

OK

Ink and Paper Consumption List
Item
Iltem names appear.

Value
For ink

* Ink consumed based on the units settings appear.
For paper
» The print area consumed for paper appear based on the units settings.

» The number of sheets printed in A4 appears.
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I Job Properties Dialog Box

The Job Properties dialog box displays detailed information about the selected job.

To open the Job Properties dialog box, from the View menu, select Job Properties or press Enter on the
keyboard.

Additionally, you can open it by double-clicking a job in the Job Cost list that you want to check the
properties of.

] Job Properties

Document Name : Document1l
Printer ; %

Printing Results : Complete

Owner : userl

Account ID :

Department (Account ID2) ;

Print Job Start Time : i -
Print Time : 00:00:24

Pages : 1

Print Quality : 4

Output Image Size : 21.000 x 29.700[cm]

Total Job Cost : 55.944[]
Total Paper Cost : 49.944(]
Total Ink Cost : 6.000[]

Total of Other Costs : 0.000[]

Total Ink Consumed : 0.120[mi]

Total Paper Consumed [Area) : 0.0623[square meter]
Paper Width : 21.000[em]

Paper Height : 29.700[cm]

Total Sheets of Paper Consumed [Converted to A4 Size] : 1

Job Cost and Consumption Details:

Item Amount Consumed  Cost []
B(Blue) Ink Cons... 0.010 0.500
C{Cyan) Ink Con... 0.010 0.500
CO(Chroma Opti... 0.010 0.500
GY(Gray) Ink Co... 0.010 0.500
M{Magenta) Ink... 0.070 0.500
MBK(Matte Blac... 0.010 0.500
PBK(Photo Blac... 0.010 0.500

Document Name
The name of the job appears.

Printer
The name of the printer that printed the job appear.
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Printing Results
The printing results for the job appears.

Owner
The name of the owner of the job appear.

Account ID
The Account ID for the job appears.

Department (Account ID2)
The Account ID2 for the job will appear here.

Print Job Start Time
The print start time for the job appears.

The Print Job Start Time that will appear is as follows:

When Time Zone Set on Printer
Displays the time converted from the time zone set on the computer running Accounting Manager.

When Time Zone Not Set on Printer
Displays the time in the time zone set on the computer running Accounting Manager.

Print Time
The print time for the job appears.

Calculates the print time based on the print start time and the print completion time included in the job
cost.

Pages
The number of pages for the job appears.

Print Quality
The level of print quality for the job appears.

Output Image Size
The output image size for the job appears.

Displayed according to unit cost settings based on the logical paper size included in the job cost.

Total Job Cost
The total costs for target jobs appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Paper Cost
The total paper costs for target jobs appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total Ink Cost
The total ink costs for target jobs appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are included
in the target jobs.

Total of Other Costs
The total value of other costs for target jobs appears.
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Total Ink Consumed
The total value of ink consumed for target jobs appears.

Total Paper Consumed [Area]
The total value of paper consumed for target jobs appears.

Total Sheets of Paper Consumed [Converted to A4 Size]
Calculates the A4 conversion value from the total value of the area of paper consumed for target jobs.

Paper Width
The width of the paper used by the job appears.

Displays the logical paper width information and the width information for paper used, according to the
unit settings based on the information acquired from the printer.

Paper Height
The length of the paper used by the job appears.

The cut sheet length information and the width information for paper used appears according to the unit
settings based on the information acquired from the printer.

Job Cost and Consumption Details
The cost and total consumption per ink color and per media type appear.

Item
The ink color and paper name appear.

Amount Consumed
The total consumption per item appears.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are
included in the target jobs.

Cost
The total costs for each item appear.

*** appears if jobs for which the cost cannot be calculated because the unit cost is not set are
included in the target jobs.

»>» Note

« If overflow occurs in the calculation results, --- appears.

« If --- appears, check the unit costs and tabulation period settings are appropriate.
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I Unit Costs Dialog Box

Set the unit costs used to calculate job cost in the Unit Costs dialog box. Set the unit costs for ink, paper,
and items other than ink and paper.

Select Unit Costs in Job Cost from the File menu to open the Unit Costs dialog box.
The Unit Costs dialog box consists of the following sheets.

= Ink sheet

= Paper sheet
= Others sheet

= Common to All Sheets

I Ink sheet

L Unit Costs { saries |

Specifies the unit costs for ink, media, and other serices.

.H' Papar | Others |
Unit Cost List:
| Ink Ciolor | bk Taend: Ca.... | Linit Coats [v]
B 4B00.000
B cCyan 330 4B00.000
Chrama Oplimizer ) 4B00.000
-] Gray a0 AE00,000
- Maganta azh 4B00.000
B Matte Black 330 AB00.000
B Photo Black 330 4B00.00D
Phote Cyan 330 4B00.000
Photo Gray 330 4B00.000
Photo Magenta 330 E00.000
| | Aed 330 AB00,000
Yallow a30 00,000
[ Apply to Al inks_
[ Acquire Printer Information [ Import... | Export.. [ Copy Unit Cost ]
| E-H.I'II:L" | |__'CI_K |
Ink Color

Ink Color and an icon indicating the ink color appear.
The ink list that appears is acquired from the selected printer.

Ink Tank Capacity
The ink tank capacity appears according to the units setting.

Unit Costs
The unit costs for Ink Color and Ink Tank Capacity appear.

If the unit costs are not set, Not set appears.

To change the unit costs settings, edit the list directly.
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Apply to All Inks button
Applies the currently selected Unit Costs and Ink Tank Capacity in Ink Color to all ink colors
displayed in Unit Cost List.

Disabled if one ink or less is displayed in Unit Cost List or no ink has been selected.

I Paper sheet

L3 Unit Costs (88 + paries )

Specifies the unit cosls for ink, media, and olher Serdicoss,

| Ink m Cihers |
Unit Cost List:
| Madia Typn | Sizn | Whdih fom] | Hizbghet [cm] | Husmber of... | Undk Coats ] |
10 0D 10,000 1 100,000
Canvas Ganeral P... 20.700 42,000 1 85.000
Matte Photo Paper A3 20.700 &2.000 1 60.000
Plain Paper AZ 20.700 42.000 i 8,000
Photo Paper Pro Presmium Matte A3 20700 42,000 1 10,000
Photo Paper Plus Semi-gloss A3 20,700 42,000 i 80.000
Heawyweight Fine Art Paper A3 28,700 42,000 1 85,000
Extra Heavywelght Fine Art P... A3 28,700 42,000 1 120,000
Heavyweight Photo Paper A3 28.700 42,000 1 90.000
Phote Paper Fro Luster AZ 28.700 42,000 1 17.0400
Unknown Paper [custom-me... A3 20.700 &2.000 1 12.000
Plain Papor Ad 21.000 29.700 1 4000
Photo Paper Ples Glossy || A 21.000 28,700 1 40,000
Photo Paper Pro Platinum A4 21,000 26,700 1 70,000
(T ek Aaa i A AL AAn an tan. L. Lnsan —
[ Age ][ Eor | I_- Dolata |
Acquine Printer Information | | Irmpart... | Export... | Copy Unit Coat |
((Gancel | (oK

Media Type
The paper name appears.

The name that appeared in the printer driver is applied.

Size
General Purpose, Regular Size Name, or Roll Paper Width Name appears.

Width
The paper width appears according to the units setting.

You can edit the list directly if Size is General Purpose.

Height
The paper length appears according to the units setting.

You can edit the list directly if Size is General Purpose or Roll Paper Width Name.

Number of Sheets/Rolls
The number of sheets in a package appears when the price per paper package is set.

If you select Roll Paper, the number of rolls appears.

Unit Costs
The price per paper package appears.

The unit cost settings you added are added to the Unit Cost List.
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Add button
Adds a new unit cost setting for paper.

The unit cost settings you added are added to Unit Cost List.

For details on Add Paper Unit Cost, see "Add Paper Unit Cost Dialog Box."

Edit button
Enables editing of the unit cost settings for paper.

Delete button
Deletes the selected paper unit costs.

Deleted paper unit costs are deleted from Unit Cost List.

I Others sheet

L Unit Costs | saries )

Spatilias thas anit coste for ink, moedia, and other services.
(_ink [ Paper [CIREENN

Unit Cost List:

Em | Uinit Coats [ | Migcats

Add | Edit | | Delete |

| Aequire Printer Information | Import... | Enpeort.. | Copy Unit Cost |

((Cancel | [ oK |

Item
Item names set for unit costs appear.

Unit Costs
The unit costs for item names appear.

Allocate
Yes or No appears for whether to include this unit cost setting when calculating job costs.

To change the settings, change them directly in the list.

Add button
Adds a new other unit cost setting.

The unit cost settings you added are added to the Unit Cost List.

Edit button
Enables editing of the settings for this unit cost.
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Delete button
Deletes the selected unit cost settings.

Deleted unit cost settings are deleted from Unit Cost List.

I Common to All Sheets

Import button
Imports unit cost settings.

Export button
Exports unit cost settings.

Copy Unit Cost button
Copies unit costs.

For details on Copy Unit Cost, see "Copy Unit Cost Dialog Box."

Acquire Printer Information button
Acquires printer information.

OK button
Saves changes to the unit cost settings and closes the Unit Costs dialog box.

Cancel button
Discards changes and closes the Unit Costs dialog box.

I Add Paper Unit Cost Dialog Box

Adds a new unit cost setting for paper.

Media Type: Matte Photo Paper ﬁ

Other Media:

Paper Size:
D General Purpose

b

Cut Sheet 11"%17" (Margin

Width [em]
Height [em]
Number of Sheets/Raolls:

Unit Coosts [¥]:

Acquire Printer Information Cancel Start

Media Type
Specify the Media Type.
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A list of the media types supported by the target printer appears.

Other Media

To set a unit cost for a paper not displayed in Media Type, select Other Media and enter the
paper ID.

You can check the paper ID on the Unspecified Unit Cost screen or in Unit Cost List on the
Paper tab of the Unit Costs screen.

"Unknown Paper [Paper ID]" appears for paper not appearing in Media Type, so enter this
paper ID.

Paper Size
Set the size type for the paper.

Select General Purpose, Roll Paper, or Cut Sheet for the size type.

Width
Specify the paper width.

If Roll Paper or Cut Sheet is selected in Paper Size, it is entered automatically.

»» Note

* If you have specified a custom size roll width in the printer driver, select Paper Size > Roll
Paper > User-defined, and then input the same value as has been set for Width in the
printer driver.

Height
Specify the paper length.

If Cut Sheet is selected in Paper Size, it is entered automatically.

Number of Sheets/Rolls
Specify the count per paper package (number of sheets).

If Roll Paper is selected in Paper Size, specify the number of rolls.

Unit Costs
Enter the price per paper package.

I Copy Unit Cost Dialog Box

Specifies the printer and items, and copies the unit cost settings.
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Specifies the printer and items, and copies the unit cost settings.

Copy From: series ﬁ
Copy To:
Printer Category
series Ink
Paper
Others
Close Start
Copy From

From the list of registered printers (same printers as displayed in the printer list on the main screen),
select the printer to copy from.

Copy To
Select the printer to copy to.

Category
Select the items to be copied.

You can select Ink, Paper, and Others individually.

»>» Note

+ If you copy unit costs, all the unit cost settings on the printer copied to will be overwritten with the unit
cost settings on the printer copied from.
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I Resident Service Settings Dialog Box

You can display the operating status of the resident service, and control the start and stop of the resident
service in the Resident Service Settings.

To open the Resident Service Settings dialog box, select Resident Service Control in the Tools menu.

The resident service must be started to acquire job logs regularly.

5

O Resident Service Settings

The service program is running.

Stop

Close

Start button
Starts the resident service.

The resident service starts automatically when the operating system is started.

Stop button
Stops the resident service.

22 Important
* If the user logs out, job logs cannot be acquired.

* If resident service is set to Stop, job logs will not be acquired regularly even if Scheduled
Acquisition Settings is set to ON for the managed printer.

To acquire job logs regularly, remain logged in with the user name that started the service.
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I Printer Management Dialog Box

You can register and unregister managed printers.

You can also change settings, and export and import information for managed printers.

I Printer Management Dialog Box

Click the ﬁ Printer Management button or select Manage Printer in Printer from the File menu to
open the Printer Management dialog box.

& Printer Management

Registers a printer to be cost-managed. To remove a managed printer, select the printer,
and then click [Remove].

Printer List
Printor Mama Connaction Schiedule... Status Add Printer...
saries  feBOueObl:aBc.. ON

import...

Export...

Concel | SEECLIN

Printer List
Displays the list of managed printers.

Printer Name
The printer name appears.

Connection
The found printer address information (connection) appears.

The Bonjour name for printers connected via Bonjour, the IP address for printers connected via
IPv4 and IPv6, and the connection port name for printers connected via USB will appear.

Scheduled Acquisition
ON appears for printers performing scheduled acquisition and OFF appears for printers not
performing scheduled acquisition.

Status
Information about the printers found appears.

Add Printer button
The Add PrinterDialog Box appears.

Printers added in the Add Printer dialog box appear in the printer list.
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Remove button
The selected printer is removed (unregistered) from the managed printers.

You can also leave unregistered printers in the printer list and continue to check job costs.
Disabled if no printers are selected or if multiple printers are selected.

Advanced Settings button
The Advanced Printer Settings Dialog Box appears.

You can check and change Printer Name, check Serial Number, check Scheduled Acquisition
Settings, set Authentication Password, and perform Auth. Test.

Disabled if no printers are selected or if multiple printers are selected.

Import button
Imports the managed printer(s) from a file.

The managed printers that are imported in Printer List appears.

22 Important

* When importing a printer connected with IPv6, you must turn on the printer and establish
communications.

If you import while communications are not established, Not Found appears under Status in the
Printer List, and the printer cannot be registered. If this happens, temporarily delete the printer
from the Printer List with the Remove button, turn on the printer, and import again after the
communications have been established.

Export button
Exports the managed printers displayed in Printer List to a file.

»» Note

» The print list to be exported does not include the authentication password used at the time of job
log acquisition.

After importing, an authentication password must be set.

* A printer connected by USB cannot be exported.

| Add PrinterDialog Box

Search for printers to be registered in the printer list on the main screen, and register managed printers.

Click Add Printer button on Printer Management dialog box to display Add Printer dialog box.
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Searches for printers, and selects the printers to be registered.

Search Method: | Bonjour B | Search j

IP Address: | |
Printer List:

| Printer | Serial Mumber | Connection
O BADMOD000S Canon | oni.
O series AEMGO0008 Cangn series-...
E saries AETA13275 Canon Series-...
] TABMT1038 Canon ._can...
O T44MT1030 Canen __can...
series AEGKO00001 _Canon seri...

| Search Options

[ Cancel ] [ Add ]

Search Method
Select the printer search method.

IP Address
Enter an IP address.

Disabled if something other than IPv4 or IPv6 is selected in Search Method.

Search button
Searches for printers using the selected Search Method.

Printer List
A list of printers found appears.

Printer
The model names of the printers found appears.

Serial Number
The serial numbers of printers found appear.

Connection
The found printer address information (connection) appears.

The Bonjour name for printers connected via Bonjour, the IP address for printers connected via
IPv4 and IPv6, and the connection port name for printers connected via USB will appear.

Stop Searching button
Click to stop the search.

The search stops after waiting until the information acquisition is completed for printers that have

been found already.

Search Options Button
Opens the Search Options dialog box.
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Configure this when searching by SNMP Community.

Add button
Closes the Add Printer dialog box.

Printers selected in the printer list appear in Printer List of the Printer Management dialog box as
managed printers.

I Advanced Printer Settings Dialog Box

You can configure advance settings for managed printers.

Sets the printer display and job log acquisition settings.
Printer Name: | 888 S8 series

Serial Number: 123456789

Scheduled Acquisition Settings
£ Run scheduled job log acquisition
Authentication

Password: ssss Auth. Test

Cancel Add

Printer Name
Specify the printer's display name in Accounting Manager.

Serial Number
The serial numbers of printers appear.

Scheduled Acquisition Settings
Set whether to perform scheduled acquisition of job logs.

To stop regular acquisition of job logs, clear the Run scheduled job log acquisition option.

32 Important

» Scheduled acquisition settings are enabled when the printer is registered. Job logs cannot be
collected if the scheduled acquisition settings are disabled.

Authentication
Set an authentication password for job log acquisition.

3> Note
» Enter the password set for the printer.

* For details, search for and refer to the "Administrator Password" page from the home page of the
Online Manual for your model.
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3% Important

« If the job history is set to hide on the printer control panel, authentication information is required
when acquiring job logs.

Auth. Test button
To perform an authentication test for job log acquisition, enter the Password and click the Auth. Test
button.

The authentication test results for job log acquisition appear in a message dialog box.

Add button
Changes the settings for the managed printer, and then closes the Advanced Printer Settings
dialog box.
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I Check Operation Status Dialog Box

Select Check Operation Status from the Tools menu to display.

A list of errors that occurred during job log acquisition appear.

] Check Operation Status
If you do not wish to see the operation status again, click [Confirm].

Operation Status:

Printer Time of Error Details

seres 2019-04-09 T16:34:.. Could not acquire the job lo..

Close Confirm

Operation Status
The acquisition status in a list appear.

Printer
The printer name appears.

Time of Error
The time the error occurred appears according the display format setting.

If the same error occurred multiple times, displays the time the error last occurred.

Details
A description of the error appears.

»>» Note

» The numbers that appear at the end of Details are added for internal identification in the
software.

Confirm button
Errors currently shown do not appear in the future.
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I Preferences Dialog Box

Specify your preferences (settings related to displayed content and displayed items) for Accounting
Manager.

This dialog box consists of the View, Unit, and Others sheets.

To display, select Preferences from the Canon Accounting Manager menu.

I View sheet

] Preferences

Unit  Others

Print Jobs Shown Per Page: | 500

Tabulation Period:  Weekly

Tabulation Start Date: | Monday

Category to Be Displayed:

Printer Mame

Account ID

Document Name

Printing Results

Media Type

Printer Paper Size

Paper Consumed [square meter] Up
Paper Width [cm)]

Paper Height [cm] Down

Sooe0000ee

Cancel oK

Print Jobs Shown Per Page
Specify the number of display items per page for job costs displayed in the list.

Tabulation Period
Set the units for the tabulation period.

Tabulation Start Date
Specify the tabulation start date for Tabulation Period.

The items that can be specified correspond to the items set in Tabulation Period and change
dynamically.

»>» Note

« If you specified Annually, "1-12" (January to December) is listed.
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Category to Be Displayed
Specify the job log items to be displayed in job cost.

Selected items appear in the list on the main screen according to the list's sort order.

Up button
Moves up the selected item one row.

Down button
Moves down the selected item one row.

I Unit sheet

@ Preferences

View W Others

Date Display Format: | YYYY/MM/DD

Currency: || . |

1000 Separator: | Mone
Decimal Symbol:
Paper Height/Area: = Single Specification
Width: | em

Height: | cm

oo o

Area: | sguare meter

Cancel oK

Date Display Format
Use this option to select the display format for dates.

"YYYY" indicates the year, "MM" the month and "DD" the day.

Currency
Enter the currency unit.

Enter a text string up to 3 characters long for the currency unit.

1000 Separator
Use this option to select the symbol used as a separator in numbers.

Decimal Symbol
Use this option to select the symbol used as a decimal point.
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Paper Height/Area
Select how to specify the paper dimensions.

Select Single Specification to specify the units for Width, Height, and Area.
Select In metric units to display units in mm for Width, m for Height, and square meter for Area.

Select In US customary units to display units in inch for Width, ft. for Height, and square feet for
Area.

»» Note

» The unit for Height will appear as mm when you select In metric units and as inch when you
select In US customary units in all dialog boxes other than the Unit Costs dialog box and
Specified Unit Cost dialog box.

Width
Use this to select the unit used for paper width.

Enabled when you select Single Specification in Paper Height/Area.

Height
Use this to select the unit used for paper length.

Enabled when you select Single Specification in Paper Height/Area.

Area
Use this to select the unit used for paper area.

Enabled when you select Single Specification in Paper Height/Area.
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I Others sheet

] Preferences

View  Unit [lel

Motification for Job Log Acquisition Error

Motify when a job log acquisition error occurs

Import... Export...

Cancel OK

Notification for Job Log Acquisition Error
Select whether a notification appears on the main screen when a job log acquisition error occurs.

+ Selected: Notify
* Not selected: Do not notify

Import button
Imports preferences.

Information that can be set in Preferences is imported.

Export button
Exports preferences.

Information that can be set in Preferences is imported.
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I Job Log Management Dialog Box

Executes operations related to job logs (Import, Export, and Delete).

This dialog box is used if you are replacing the computer used for management, changing the job log
destination, or increasing hard disk capacity.

To display, select Job Log Management from the File menu.

I Import sheet
Imports job logs.

& Job Log Management

m Export  Delete

Imports the job logs.

File: Browse...

Close

File
Specify the file to be imported.

Browse button
A dialog box for specifying a file appears.

Start button
The job log specified in File is imported.

I Export sheet

Exports job logs. Exports the collected job information to a file.
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@ Job Log Management

Import m Delete

Exports the job logs.

Destination: Browse...
Target Printer: = All
Target Period: i/ = i
Close
Destination

Specify an export destination.

Browse button
A dialog box for specifying a file appears.

Target Printer
Select the printer for export.

»» Note

* Previously managed printers that have been unregistered appear with their MAC addresses.

Target Period
Specify an export target period.

Start button
Exports the job logs to the specified destination.

I Delete sheet

Deletes the job logs.
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] Job Log Management

Tl S o

Import  Export lete
Deletes the stored job logs.
Target Printer; = All E
Target Period: =T = [y
Close Start

Target Printer
Select the printer for which job logs are deleted.

»>» Note

» Previously managed printers that have been unregistered appear with their MAC addresses.

Target Period
Specify the period for deletion.

Start button
Deletes the job logs that meet the specified criteria.

102



